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FD-11637 User Guide 

The FieldDAQ FD-11637 is an IP65/IP67-rated eight-channel strain/bridge input device 
that includes all the signal conditioning required to power and measure up to eight 
bridge-based sensors simultaneously. It can be networked and synchronized with 
IEEE 802.1AS devices. 

Figure 1. FD-11637 Front Panel 
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1. Power IN Connector 
2. Power LED 
3. Ethernet Port 0 and LED 
4. Bank 1 Input Connectors 0 through 3 and LEDs 
5. Bank 2 Input Connectors 0 through 3 and LEDs 
6. Mounting Holes 
7. Power OUT Connector 
8. STATUS LED 
9. Ethernet Port 1 and LED 

10. SYNC Logo 
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FD-11637 Basic Information 

Kit Contents 

Items in your FieldDAQ kit: 

• FD-11637 
• FD-11637 Quick Start 
• FD-11637 Safety, Environmental, and Regulatory Information 
• 1 M12 female cap for power IN connector (connected to device) 
• 11 M12 male caps for power OUT, Ethernet, and input connectors (connected to 

device) 

Pinouts 

Refer to the following topics for the connector pinouts on your FieldDAQ device: 

• Strain/bridge connector pinout: Refer to Strain/Bridge Connectors. 
• Ethernet connector pinout: Refer to Ethernet Ports. 
• Power connector pinout: Refer to Power Connectors. 

Driver Support 

Earliest driver support version for your FieldDAQ device: 

Table 1. FD-11637 Driver Support 

Driver Earliest Version Support 

NI-DAQmx 17.6 

Cables and Accessories 

The following table lists some cables and accessories available for your FieldDAQ 
device. For a complete list of FieldDAQ accessories and ordering information, refer to 
the pricing section of the FD-11637 product page at ni.com. 
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Table 2. FD-11637 Cables and Accessories 

Cable/Accessory Part Number 

IP67 Power Supply 147464-01 

PS-16 Power Supply 781094-01 

M125F-Pigtail Power Cable (1 m, 2 m, 3 m 
lengths) 786172-01/02/03 

M125F-M125M Power Cable (0.3 m, 1 m, 3 m 
lengths) 786173-0R3/01/03 

SHM128M-RJ45 Ethernet Cable (1 m, 2 m, 3 m, 
10 m lengths) 785944-01/02/03/10 

SHM128M-SH128M Ethernet Cable (0.3 m, 1 m, 
3 m lengths) 785946-0R3/01/03 

SHM128M-Pigtail, TP I/O Cable (0.3 m, 1 m, 3 m 
lengths) 786325-0R3/01/03 

SHM128M-Pigtail-RA, TP I/O Cable (0.3 m, 1 m, 
3 m lengths) 786326-0R3/01/03 

FD-11952, M128F Field-serviceable I/O 
Connector 785940-01 

FD-11953, M128F-RA Field-serviceable I/O 
Connector 785943-01 

M12 Torque Wrench, Ethernet and I/O 786181-01 

M12 Torque Wrench, Power 786182-01 

Universal M12 Male Cap, Plastic 786177-01 

Universal M12 Male Cap, Metal 786178-01 

Universal M12 Female Cap, Plastic 786180-01 

Universal M12 Female Cap, Metal 786179-01 

FD-11960, DIN Rail Mounting Kit 786443-01 

FD-11637 Documentation 

Documents that contain information about your FieldDAQ device: 
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• FD-11637 Specifications 
• FD-11637 Quick Start 
• FD-11637 Safety, Environmental, and Regulatory Information 
• FD-11637 Calibration Procedure 

Safety Guidelines 

The FD-11637 is rated for use in DRY or WET LOCATIONS. Hazardous voltages may not 
be connected to the device. A hazardous voltage is a voltage greater than 42.4 V peak 
voltage or 60 V DC in DRY LOCATIONS, and 22.6 V peak or 35 V DC in WET LOCATIONS. 

EMC Guidelines 

This product was tested and complies with the regulatory requirements and limits for 
electromagnetic compatibility (EMC) stated in the product specifications. These 
requirements and limits provide reasonable protection against harmful interference 
when the product is operated in the intended operational electromagnetic 
environment. 

This product is intended for use in industrial locations. However, harmful interference 
may occur in some installations, when the product is connected to a peripheral device 
or test object, or if the product is used in residential areas. To minimize interference 
with radio and television reception and prevent unacceptable performance 
degradation, install and use this product in strict accordance with the instructions in 
the product documentation. 

Furthermore, any changes or modifications to the product not expressly approved by 
NI could void your authority to operate it under your local regulatory rules. 

Caution Do not operate the FD-11637 in a manner not specified in this user 
guide. Product misuse can result in a hazard. You can compromise the safety 
protection built into the product if the product is damaged in any way. If the 
product is damaged, return it to NI for repair. 

Caution All wiring must be insulated for the highest voltage used. 
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Electromagnetic Compatibility Notices 

Refer to the following notices for cables, accessories, and prevention measures 
necessary to ensure the specified EMC performance. 

Special Conditions for Marine Applications 

Some products are approved for marine (shipboard) applications. To verify marine 
approval certification for a product, visit ni.com/product-certifications, search by 
model number, and click the appropriate link. 

Unpacking 

The FD-11637 ships in an antistatic package to prevent electrostatic discharge (ESD). 
ESD can damage several components on the device. 

To avoid ESD damage in handling the device, take the following precautions: 

• Ground yourself with a grounding strap or by touching a grounded object. 
• Touch the antistatic package to a metal part of your computer chassis before 

removing the device from the package. 

Remove the device from the package and inspect it for loose components or any other 
signs of damage. Notify NI if the device appears damaged in any way. Do not install a 

Notice To ensure the specified EMC performance, operate this product only 
with shielded cables and accessories. 

Notice In order to meet the EMC requirements for marine applications, 
install the product in a shielded enclosure with shielded and/or filtered 
power and input/output ports. In addition, take precautions when designing, 
selecting, and installing measurement probes and cables to ensure that the 
desired EMC performance is attained. 

Notice Never touch the exposed pins of connectors. 
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damaged device. 

Store the device in the antistatic package when the device is not in use. 

Hardware Symbol Definitions 

The following symbols are marked on your FieldDAQ device. 

When this symbol is marked on a product, refer to Safety Guidelines for information 
about precautions to take. 

At the end of the product life cycle, all NI products must be disposed of according to 
local laws and regulations. For more information about how to recycle NI products in 
your region, visit ni.com/environment/weee. 

5 40e

NI符合中国电子信息产品中限制使用某些有害物质指令(RoHS)。关于NI中国RoHS合
规性信息，请登录 ni.com/environment/rohs_china。(For information 
about China RoHS compliance, go to ni.com/environment/rohs_china.) 

What You Need to Get Started 

You will need the following items to set up your FieldDAQ device. 

Figure 1. FieldDAQ Installation Supply List 
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1. Host Computer running Windows or NI Linux RT 
2. Application Software 
3. NI-DAQmx Driver 
4. FieldDAQ Device 
5. 5-pin L-coded M12 Power Input Cable 
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6. 8-pin X-coded M12 Ethernet Cable 
7. External Power Supply 
8. 8-pin A-coded M12 I/O Cables and Accessories 

Setting up the FieldDAQ Device 

Complete the following steps. 

1. Install the application software (if applicable), as described in the installation 
instructions that accompany your software. Check your driver and application 
development environment (ADE) readme files for specific version compatibility. 

2. Install NI-DAQmx from ni.com/downloads/drivers. Complete the instructions. 
3. Register your NI hardware online at ni.com/register when prompted. The last 

dialog box opens with the following options: 
◦ Restart Later to install more NI software or documentation. 
◦ Shut Down or Restart if you are ready to install your device. 

If you have problems installing your software, go to ni.com/support/daqmx. 

4. (Optional) Mount the FieldDAQ device to a panel or DIN rail, as described in 
Mounting. 

5. Make signal connections. Refer to Strain/Bridge Connectors and Measurements for 
information about signal connections and guidelines. 

6. Align and connect one end of the Ethernet cable to Ethernet port 0 on the device, 
and the other end directly to your computer or any network connection on the 
same subnet as your computer. 

7. Power the device by aligning and connecting the power IN port on FieldDAQ to an 
external 9 V DC to 30 V DC power source with the 5-pin L-coded M12 power cable. 
For information about wiring your external power source to the power connector, 
refer to Wiring External Power to the FieldDAQ Device. The FieldDAQ device 
requires an external power supply that meets the specifications listed in the 
FD-11637 Specifications. 

Note You can either use a shielded straight-through Ethernet cable or an 
Ethernet crossover cable to connect the FieldDAQ device directly to your 
computer. 
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The Power LED turns on. Refer to Power LED for information about Power LED 
status. 

8. To add the FieldDAQ to your software configuration, open NI MAX on your Windows 
host computer. Expand Devices and Interfaces » Network Devices. 

◦ If the device is on your local subnet, the device automatically appears in the 
list of available devices. Right-click the FieldDAQ device and select Add Device. 

◦ If the device is not on your local subnet, right-click Network Devices and select 
Find Network NI-DAQmx Devices. 
a. In the Find Network NI-DAQmx Devices dialog box that opens, do one of 

the following: 
▪ Check the box that corresponds to your device in the Hostname 

column. 
Figure 1. Find Network NI-DAQmx Devices 

▪ If you know the device IP address, such as 192.168.0.2, enter it into the 
Add Device Manually field of the Find Network NI-DAQmx Devices 
window, and click the + button. 

▪ Enter the hostname of the device. The default hostname is 
FD11637-<serial number>. 
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b. Click Add Selected Devices. 

The FieldDAQ device icon changes from white to dark grey, indicating that 
it is recognized and present on the network. 

Figure 1. MAX Icons and States 

21 3

1. Discovered, but Not Added to the Network 
2. Recognized, Present, and Reserved on the Network 
3. Recognized, but Disconnected from the Network, Unreserved, or 

Reserved by Another Host 
If your device does not appear in Available Devices, click Refresh List. If the 
device still does not appear, try the following: 
▪ If you connected the FieldDAQ device directly to your computer, ensure 

your network card is configured to obtain an IP address automatically, 
then click Refresh List. 

▪ Contact your system administrator to confirm that the network is 
working and that a firewall is not interfering with discovery. For 
additional troubleshooting resources for the FieldDAQ device, refer to 
the Troubleshooting Device Connectivity in this guide and the Finding 
a Network DAQ Device in MAX topic in the Measurement & 
Automation Explorer Help for NI-DAQmx. 

Note If you connected the FieldDAQ device directly to your 
computer, the setup time may be longer. Wait 30 to 60 
seconds after the STATUS LED turns off, then click Refresh 
List. 
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Figure 1. Network Devices in MAX 

9. If the FieldDAQ device is not reserved automatically, select the device and click the 
Reserve Network Device button. Refer to Reserving the Device in MAX for more 
information. 

10. Self-test your device in MAX by expanding Devices and Interfaces » Network 
Devices, right-clicking your FieldDAQ device, and selecting Self-Test. Self-test 
performs a brief test to determine successful device installation. When the self-test 
finishes, a message indicates successful verification or if an error occurred. If an 
error occurs, refer to ni.com/support/daqmx. 

11. Run a test panel in MAX by expanding Devices and Interfaces » Network Devices »
your FieldDAQ device, right-clicking the bank of connectors in your FieldDAQ 
device, and selecting Test Panels. If the test panel displays an error message, refer 
to ni.com/support. Click Close to exit the test panel. 

For instructions on networking to a real-time controller, refer to Connecting to a Real-
Time Controller. 

Note When in use, the FieldDAQ device may become warm to the touch. This 
is normal. 

Note M12 connectors must be mated to cables or have caps installed on 
them to meet IP65/IP67 requirements. Cover the unused connectors with the 
included plastic caps whenever water, dust, or dirt are present. 

Note Avoid long periods of exposure to sunlight. 
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Power Connectors and Wiring 

The FieldDAQ device has two 5-pin L-coded M12 power connectors, power IN and 
power OUT. The power connectors provide one voltage line (V), one common line (C), 
chassis ground, and two lines for optional auxiliary power, Aux1 and Aux2. 

The following figure shows the power circuitry on the FieldDAQ device. 

Figure 1. Power Circuitry 
IN OUT

Chassis Ground

Internal Circuit

Aux
V
C

The FieldDAQ device requires an external power source connected between the V and 
C terminals, as described in Power Requirements in the FD-11637 
Specifications. The FieldDAQ device internally connects the C terminal to the chassis 
ground. Recommended NI power supplies are listed in FD-11637 Basic Information. 

The FD-11637 has a maximum device power consumption of 15 W. Each FieldDAQ 
filters and regulates the supplied power for its tasks. 

When FieldDAQ devices are linked together through the power IN and power OUT 
connectors, the total current consumption of the chain equals the sum of every linked 
FieldDAQ device’s current consumption. The total current cannot exceed 10 A, and the 
total supply load of the chain must be less than 300 W. 

You can use the optional auxiliary power lines (Aux1 and Aux2) to draw power for 
non-FieldDAQ devices in your network. The FieldDAQ device does not make use of the 
auxiliary power itself. If you are connecting power through the auxiliary power lines, 
ensure that the total combined current between V Input and Aux power lines does not 
exceed 10 A. 

FD-11637

© National Instruments 13



Refer to the FD-11637 Specifications for information about the power connectors, 
power requirements, and current limits of your FieldDAQ device. 

Cap the power connectors when not in use. 

Power Connectors 

The following figure shows the pinout of the Power IN connector. 

Figure 1. Power Connector Pinout 
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Table 3. Signal Descriptions 

Pin Number Wire Color* Signal Description 

1 Brown V Positive voltage 
line 

2 White Aux2 
Optional line for 
powering non-
FieldDAQ devices 

3 Blue C 
Common. 
Negative voltage 
line 

4 Black Aux1 
Optional line for 
powering non-
FieldDAQ devices 

5 Gray 

Chassis Ground. 
This terminal is 
internally 
connected to the 
C terminal. 

* Wire color pertains to M125F power cables sold through NI. Other manufacturers' cable wire 
colors may vary. 
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Power LED 

The green POWER LED on the front panel identifies when the device is powered. 

Table 4. LED State/Device Status 

LED State Device Status 

On Device is receiving adequate power for its tasks. 

Off Device is unpowered or receiving inadequate 
power. 

Wiring External Power to the FieldDAQ Device 

Complete the following steps to connect a power source to the FieldDAQ device. 

1. Verify the power source is turned off. 
2. If you are not using a pre-assembled cable, complete the following steps. 

a. Connect the positive lead of the primary power source to the V terminal (pin 1) 
inside the power connector plug. 

b. Connect the negative lead of the primary power source to the C terminal (pin 3) 
inside the power connector plug. 

c. Connect the Chassis Ground terminal (pin 5) inside the power connector plug 
to earth ground. This terminal is internally connected to the C terminal. 

d. (Optional) To power non-FieldDAQ devices through the power network, 
connect the leads of an additional auxiliary power source to the Aux1 (pin 4) 
and Aux2 (pin 2) terminals inside the power connector plug. 

e. Assemble the rest of the plug sleeve. 
3. Carefully align and connect the cable to the external power source and the power 

IN connector on the FieldDAQ device. 
4. Turn on the external power source. 

If the power source is connected to the power connector using long wiring with high 
DC resistance, the voltage at the power connector may be significantly lower than the 
specified voltage of the power source. 

Refer to Power Requirements in the FD-11637 Specifications for information 
about the power supply input range. Refer to Safety Voltages in the FD-11637 
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Specifications for information about the maximum voltage from terminal to chassis 
ground. 

Signal Connectors and Measurements 

The following figures show strain/bridge input circuitry and block diagram of the 
FD-11637. 

Figure 8. FD-11637 Input Circuitry 
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Figure 9. FD-11637 Block Diagram 
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The FD-11637 features two banks, Bank 1 and Bank 2, each containing four channels. 
Each channel has an independent 24-bit ADC and an input amplifier that enables you 
to sample signals from all eight channels simultaneously. 

The FD-11637 is isolated from earth ground. The individual channels are isolated from 
each other. The FieldDAQ device provides overvoltage protection for each channel; 
refer to the FD-11637 Specifications for more information about overvoltage 
protection. 

Refer to Connecting Strain/Bridge Signals for full-, half-, and quarter-bridge connection 
information. 

Strain/Bridge Connectors 

The FD-11637 features eight 8-pin A-coded M12 connectors. The following figure shows 
the pinout of a strain/bridge input connector. The FD-11637 provides connections for 
eight quarter-, half- or full-bridge connections. 
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Figure 10. FD-11637 Pinout 
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Table 5. Signal Descriptions 

Pin Number Wire Color* Signal Description 

1 White EX+ Positive sensor 
excitation 

2 Brown T+ TEDS data 

3 Green T- TEDS return 

4 Yellow AI- Negative analog 
input signal 

5 Gray RS+ Positive remote 
sense 

6 Pink AI+ Positive analog 
input signal 

7 Blue RS- Negative remote 
sense 

8 Red EX- Negative sensor 
excitation 

* Wire color pertains to SHM128M I/O cables sold through NI. Other manufacturers' cable wire 
colors may vary. 

Strain/Bridge LEDs 

Each signal connector has an LED. Refer to Excitation for information about 
troubleshooting gage resistance and excitation voltages. 

Note M12 connectors must be mated to cables or have caps installed on 
them to meet IP65/IP67 requirements. Cover the unused connectors with the 
included plastic caps whenever water, dust, or dirt are present. 
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Table 6. LED Status 

LED Color and State Connector Status 

Off Nothing connected or high gage resistance 

Red, solid Overload. Gage resistance is too low for the 
excitation voltage 

Green, solid Strain gage connected 

Yellow, blinking/alternating 

User-defined status. Use MAX to write a state to 
any LED by expanding Devices and Interfaces »
Network Devices » your FieldDAQ device »
bank of connectors in your FieldDAQ 
device and configuring the LED settings on the 
Settings tab. 

Connecting Strain/Bridge Signals 

You can connect full-bridge, half-bridge, and quarter-bridge signals to the FieldDAQ 
device. Refer to the FieldDAQ Physical Channels topic in the NI-DAQmx Help for 
more information about how to use the NI-DAQmx API to take bridge measurements. 

If your device also features TEDS sensors, refer to Connecting TEDS Sensors for 
additional TEDS connection information. 

• Full-Bridge Signals—You can connect a ground referenced or floating full-bridge 
signal to the FieldDAQ device. When connecting floating signals to the FieldDAQ 
device, NI recommends connecting the EX- signal (pin 8) to the earth ground or 
shield for better noise rejection. Remote sense connections are recommended; 
refer to Remote Sensing and Shunt Calibration for remote sense use cases. 

Note When you turn off the LEDs in MAX, the FieldDAQ device controls and 
sets the state of the LED. You cannot configure an LED while a task is running. 

FD-11637
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Figure 11. Connecting a Full-Bridge Signal to the FieldDAQ Device 
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• Half-Bridge Signals—You can connect a ground referenced or floating half-bridge 
signal to the FieldDAQ device. When connecting floating signals to the FieldDAQ 
device, NI recommends connecting the EX- signal (pin 8) to the earth ground or 
shield for better noise rejection. Remote sense connections are recommended; 
refer to Remote Sensing and Shunt Calibration for remote sense use cases. 

Figure 12. Connecting a Half-Bridge Signal to the FieldDAQ Device 
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Note When you insert a sensor in to the FieldDAQ device, slight changes 
in the excitation voltages can cause a mismatch between the internal 
half-bridge completion resistors and the half-bridge sensors, which 
results in a change in the measurement offsets. NI recommends 
performing offset nulls of quarter- or half-bridge sensors after attaching 
any sensor to the FieldDAQ device. Use the DAQmx Perform Bridge Offset 
Nulling Calibration VI/function or the DAQ Assistant with the Software 
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• Quarter-Bridge Signals—You can connect a ground referenced or floating quarter-
bridge signal to the FieldDAQ device by adding a resistor externally to create a half 
bridge, as shown in the following figure. Internal shunt calibration allows for 
quarter-bridge connections. The FieldDAQ device supports internal quarter-bridge 
completion with resistances of 120 Ω and 350 Ω. Shunt calibration can correct for 
errors caused by wire resistance within an arm of the quarter bridge; refer to 
Remote Sensing and Shunt Calibration for more information. 

Figure 13. Connecting a Quarter-Bridge Signal to the FieldDAQ Device 
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Compensation (Initial Bridge Voltage) method to perform an offset 
nulling calibration. Refer to the Offset Nulling (Bridge Balancing) 
topic of the NI-DAQmx Help for more information. 

Note When you insert a sensor in to the FieldDAQ device, slight changes 
in the excitation voltages can cause a mismatch between the internal 
half-bridge completion resistors and the half-bridge sensors, which 
results in a change in the measurement offsets. NI recommends 
performing offset nulls of quarter- or half-bridge sensors after attaching 
any sensor to the FieldDAQ device. Use the DAQmx Perform Bridge Offset 
Nulling Calibration VI/function or the DAQ Assistant with the Software 
Compensation (Initial Bridge Voltage) method to perform an offset 
nulling calibration. Refer to the Offset Nulling (Bridge Balancing) 
topic of the NI-DAQmx Help for more information. 
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Connecting TEDS Sensors 

You can connect TEDS (Transducer Electronic Data Sheets) sensors to the FieldDAQ 
device through the T+ and T- pins on each connector. Ensure that the TEDS data (T+) or 
the TEDS return (T-) signals are not connected to any of the bridge signals on the 
FieldDAQ device. 

Figure 14. Connecting TEDS Sensors to the FieldDAQ Device 

T+Data
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Remote Sensing and Shunt Calibration 

Wiring resistance can create resistance errors in bridge circuits. The FieldDAQ device 
provides two mechanisms to correct for these errors: 

• Remote Sensing—Use remote sensing with half- and full-bridge sensors. Remote 
sensing continuously and automatically corrects for errors in excitation leads. 

Long wire and small gage wire have greater resistance, which can result in gain 
error. The resistance in the wires that connect the excitation voltage to the bridge 
causes a voltage drop, which is a source of gain error. The FieldDAQ device 
includes remote sensing to compensate for this gain error. Connect remote sense 
wires to the points where the excitation voltage wires connect to the bridge circuit. 
Refer to the following figure for an illustration of how to connect remote sense 
wires to the FieldDAQ device. 

Figure 15. Connecting Remote Sense Wires to the FieldDAQ Device 
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The actual bridge excitation voltage is smaller than the voltage at the EX+ and EX- 
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pins due to the voltage drop across the resistance of the leads. If you do not use 
remote sensing of the actual bridge voltage, the measured value will be the ratio of 
the ±AI voltage to the ±EX voltage and will result in a gain error of: 

◦ 2 · Rlead/Rbridge for full-bridge sensors 
◦ Rlead/Rbridge for half-bridge sensors 

For example, if you connected a 350 Ω full-bridge sensor with lead wires that each 
had 0.35 Ω of resistance, you would observe a gain error of -(2 * 0.35)/350 = -0.2%, 
and all of your readings would be reduced by -0.2%. 

If you connect the remote sense signals directly to the bridge resistors, the 
FieldDAQ device senses the actual bridge voltage and eliminates the gain errors 
caused by the resistance of the EX+ and EX- leads by returning a measured value 
that is the ratio of the ±AI voltage to the ±RS voltage. If you leave the remote sense 
signals disconnected (for example, in a 4-wire connection to a full bridge sensor), 
the FieldDAQ device automatically senses the excitation voltage at the device. 

• Shunt Calibration—Use shunt calibration instead of remote sense with quarter-
bridge sensors. Shunt calibration can correct for gain errors from the resistance of 
the lead wires between the EX pins on the FieldDAQ device and the strain gage. The 
gain errors caused by lead wire resistance are the same for quarter bridge mode as 
for half bridge: 

Rlead/Rbridge 

Shunt calibration involves simulating the input of strain by changing the resistance 
of the internal quarter-bridge completion resistor by some known amount. This is 
accomplished by shunting, or connecting, a large resistor of known value across 
the internal completion resistor, creating a known change in resistance. You then 
compare the change in measured value of the gage before and after shunting to 
the expected change. You can use the results to correct gain errors in the entire 
measurement path, or to simply verify general operation to gain confidence in the 
setup. The FieldDAQ provides an internal precision, shunt resistance, and a 
software control switch, as shown in the following figure. In 120 Ω mode, a 
49.66 kΩ shunt is used; in 350 Ω mode, a 49.90 kΩ shunt is used. 
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Figure 16. Connecting Shunt Calibration Wires to the FieldDAQ Device 
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To perform a shunt calibration with the FieldDAQ device, connect your external 
strain gage as shown in the figure and ensure that you have a stable signal, which 
is typically the unloaded state of the sensor. Acquire a measurement of the input 
first with the shunt calibration switch off and then again with the switch on. 
Subtract the first reading from the second reading, and compare this change with 
shunt calibration to the nominal values in the following table to get an indication 
of the gain errors from wiring resistance. 

Table 7. Expected Shunt Calibration Values 

Quarter-Bridge Resistance Nominal Change in Reading with Shunt 
Calibration 

120 Ω -603.4 µV/V 

350 Ω -1747.4 µV/V 

You can correct future readings for the gain error caused by your lead wire 
resistance by multiplying future readings by this correction factor: 

Correction Factor = Nominal Change (from table)/Measured Change 

Use the DAQmx Perform Shunt Calibration VI/function or the DAQ Assistant to 
perform a shunt calibration, which sets the gain adjustment for a virtual channel. 
NI-DAQmx then uses this gain adjustment when scaling readings from the bridge. 
You must use the DAQmx Perform Bridge Offset Nulling Calibration VI/function 
immediately prior to using the DAQmx Perform Shunt Calibration VI/function 
because the Shunt Calibration uses the result of the Offset Nulling calibration as 
the unshunted value. 

FD-11637

24 ni.com



Excitation 

You can program the FieldDAQ device to supply 3 V, 5 V, or 10 V of excitation voltage. 
10 V excitation is only supported in full-bridge and half-bridge modes. In quarter-
bridge mode, the FieldDAQ device supports connection of a single external resistance 
or strain gage of either 120 Ω or 350 Ω. In full- and half-bridge modes, the minimum 
allowable load resistance between the EX+ and EX- pins is 225 Ω with 10 V excitation 
and 108 Ω with 5 V or 3 V excitation. 

The FieldDAQ device goes into a current limited mode to protect the excitation supply 
from short circuits or load resistance values lower than those listed above. In this 
current limited mode, the Overcurrent status is set in NI-DAQmx and the Strain/Bridge 
LED lights red. 

The FieldDAQ device also has an open circuit detection mode to indicate whether a 
sensor is connected. In all modes and excitation voltages, an open circuit is detected if 
the total load resistance is greater than 1.2 kΩ. When an open circuit is detected, the 
Open Channel status is set in NI-DAQmx and the Strain/Bridge LED turns off. 

If a connected sensor applies a total resistance above the minimum values and below 
1.2 kΩ, the Strain/Bridge LED lights green. 

The following table summarizes the supported excitation voltages for each element of 
most common bridge resistance values. 

Table 8. Supported Excitation Voltages for Common Values of Rbridge 

Rbridge Quarter-Bridge Half-Bridge Full-Bridge 

120 Ω 3 V, 5 V 3 V, 5 V, 10 V 3 V, 5 V 

350 Ω 3 V, 5 V 3 V, 5 V, 10 V 3 V, 5 V, 10 V 

1 kΩ Not supported Refer to the note 3 V, 5 V, 10 V 

Note: The total resistance of a half-bridge with 1 kΩ elements is 2 kΩ, which exceeds the open 
channel detection threshold of the FieldDAQ device. The FieldDAQ device operates and measures 
such half bridges correctly, but they may not result in the Strain/Bridge LED lighting and may cause 
the Open Channel flags to be set in NI-DAQmx. 
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Filtering 

The FieldDAQ device uses a combination of analog and digital filtering to provide an 
accurate representation of in-band signals and reject out-of-band signals. The filters 
discriminate between signals based on the frequency range, or bandwidth, of the 
signal. The three important bandwidths to consider are the passband, transition band, 
and stopband. The FieldDAQ filters are designed to provide full alias protection from 
any signal component of more than one-half the sampled data rate. As such, the 
FieldDAQ filters track the sampled data rate and the frequency range of the passband, 
transition band, and stopband are all proportional to the sampled data rate. 

• Passband—The signals within the passband have frequency-dependent gain or 
attenuation. The small amount of variation in gain with respect to frequency is 
called the passband flatness. The following figure shows the typical passband 
flatness at three different sampled data rates. As the figure indicates, the passband 
always extends to 0.4 times the sampled data rate before the roll-off of the 
transition band begins. Refer to the FD-11637 Specifications for details on the 
amount of variation in the passband gain and signal delay you can expect for 
different frequency ranges. 

Figure 17. Typical Passband Flatness 
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1

1. Roll-off starts at 0.4 times the data rate 

• Transition Band—The transition band spans the frequency range between 0.4 
times and 0.5 times the sampled data rate. The transition band scales precisely 
with sampled data rate. The following figure shows the transition band frequency 
response and the beginning of the stopband response. 
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Figure 18. Transition Band and Stopband 
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1. Transition band starts at 0.4 times the sampled data rate 
2. Stopband starts at 0.5 times the sampled data rate 

• Stopband—The filter significantly attenuates all signals above the stopband 
frequency. The primary goal of the filter is to prevent aliasing. Therefore, the 
stopband frequency scales precisely to equal 0.5 times the sampled data rate. The 
stopband rejection is the minimum amount of attenuation applied by the filter to 
all signals with frequencies within the stopband. 

Data Rates 

You can use the 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz timebases to 
generate data rates. The FD-11637 supports data rates (fs) between 500 Samples/s and 
102.4 kSamples/s. By default, NI-DAQmx automatically chooses the most suitable 
timebase for a selected data rate. You can also manually select a timebase through the 

NI-DAQmx API.[1] Refer to Timebases in this guide and the FD-11637 Specifications 
for information about choosing the correct timebase for your data rate. 

Programming the FieldDAQ Device 

You can use the FieldDAQ device in the following analog input applications: 

• Finite acquisition 
• Continuous acquisition 

The FieldDAQ device features the following timing and triggering signals: 

• AI Sample Clock Signal 
• AI Sample Clock Timebase Signal 
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• AI Start Trigger Signal 
• Analog Input Sync Pulse 

For more information about programming analog input applications and triggers in 
software, refer to the NI-DAQmx Help or the LabVIEW Help for more information. 

AI Sample Clock Signal AI Sample Clock Signal 

A sample consists of one reading from each channel in the AI task. Sample Clock 
signals the start of a sample of all analog input channels in the task. Refer to the 
following figure for sample clock source options. 

Figure 19. AI Sample Clock Timing Options 
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The FD-11637 is considered a Delta-Sigma device; it contains multiple A/D converters 
that require a high-frequency oversample clock to produce accurate, synchronized 
data. The FieldDAQ device returns a sample on every Sample Clock pulse. 

The oversample clock is used as the AI Sample Clock Timebase. The FieldDAQ device 
supplies 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz timebases. By default,NI-

DAQmx automatically chooses the most suitable timebase for a selected data rate.[2] 

The FieldDAQ device automatically issues a synchronization pulse to each bank that 
resets their ADCs at the same time. You can also specify a specific time for the 
synchronization pulse to occur. Because of the filtering used in the Delta-Sigma 
FieldDAQ device A/D converters, these devices exhibit a fixed input delay relative to 
non-Delta-Sigma devices in the system. This input delay is specified in the FD-11637 
Specifications. 

When using multiple FieldDAQ devices in a task that contains channels for a Delta-
Sigma device, such as the FD-11637, ensure that one of those channels is the first in 
your channel list. 
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AI Sample Clock Timebase Signal AI Sample Clock Timebase Signal 

The AI Sample Clock Timebase signal is divided down to provide a source for Sample 
Clock. 

AI Start Trigger Signal AI Start Trigger Signal 

Use the Start Trigger signal to begin a measurement acquisition. A measurement 
acquisition consists of one or more samples. If you do not use triggers, begin a 
measurement with a software command. Once the acquisition begins, configure the 
acquisition to stop in one of the following ways: 

• In finite mode, when a certain number of points has been sampled 
• In continuous mode, with a software command 

You can specify a default delay from the Start Trigger to the first sample. 

Use the Start Trigger signal with a time source, by specifying a specific time in NI-
DAQmx. Refer to the Time Triggering topic in the NI-DAQmx Help for more 
information on accessing time-based features in the NI-DAQmx API. 

Analog Input Sync Pulse Analog Input Sync Pulse 

You can use time as a trigger for sync pulses on the FieldDAQ device. To use a sync 
pulse with a time source, specify a specific time in NI-DAQmx. Refer to the Time 
Triggering topic in the NI-DAQmx Help for more information on accessing time-
based features in the NI-DAQmx API. 

Time-Based Triggers 

FieldDAQ devices feature automatic network-based synchronization with compatible 

Note To accurately synchronize Delta-Sigma devices in two or more separate 
tasks, you must specify the same sync pulse. Otherwise, a sync pulse is 
initiated by software implicitly, even if time start triggers are specified for the 
tasks. However, for multidevice tasks, the sync pulses and start triggers are 
automatically synchronized. 
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networks and IEEE 802.1AS-capable NI Linux Real-Time controllers. The SYNC logo on 
the device front panel indicates that the device is capable of hardware-based 
synchronization over a network. 

FieldDAQ devices can be daisy-chained together or connected to external networks 
that support IEEE 802.1AS synchronization, and all device timebases will be 
automatically synchronized. Refer to Synchronization across a Network for more 
information about supported topologies and other technical requirements. 

Network-synchronized devices can also take advantage of time-based synchronization 
features in NI-DAQmx. Certain triggers can be specified in terms of time of day. 
Time-based triggers and multidevice tasks (spanning multiple network-synchronized 
FieldDAQ devices) can help simplify programming for large systems. 

Time triggers can be specified in Host Time or I/O Device Time, depending on the 
needs of your application. 

• I/O Device Time—The time the FieldDAQ device uses internally. This time is 
determined by the network configuration and is shared by all IEEE 802.1AS 
network-synchronized devices on your subnet. 

• Host Time—The time on your Windows computer or NI Linux Real-Time controller. 
This is usually the current global time and is provided by a local real-time clock or 
a network time protocol (NTP) server. 

NI-DAQmx automatically translates from Host Time to I/O Device Time as necessary. 
The accuracy of this translation depends on the relationship between these times and 
can reduce the relative accuracy of time triggers across multiple devices. For 
maximum accuracy, use an NI Linux Real-Time controller as the host in a supported 
topology. However, NI-DAQmx guarantees that two tasks configured to start at the 
same host time always start at the same I/O Device Time in all scenarios, preserving 
precise synchronization between chassis in this common use case. Refer to the Time 
Triggering topic in the NI-DAQmx Help for more information on accessing 
time-based features in the NI-DAQmx API. 

Timebases 

The following figure shows the FD-11637 clock routing circuitry and timebases. 
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Figure 1. Clock Routing Circuitry 
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You can use the 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz timebases to 
generate the AI Sample Clock signals. These timebases are generated directly from the 
onboard clock generator. By default, NI-DAQmx automatically chooses the most 

suitable timebase for a selected data rate.[3] You can also manually select a timebase 
through the NI-DAQmx API. 

Refer to the FieldDAQ Timing Considerations and Master Timebase 
Synchronization topics in the NI-DAQmx Help for more information about 
configuring timing in the NI-DAQmx API. 

Synchronization across a Network 

The onboard 100 MHz oscillator automatically synchronizes to other network-
synchronized devices that are part of your local IEEE 802.1AS subnet. 

The 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz Timebases are derived from 
the oscillator, and are synchronized to it. Therefore, they are also synchronized to 
other network-synchronized timebases on your IEEE 802.1AS subnet. This enables 
measurement signals to be synchronized to other devices across a distributed 
network. 

The FieldDAQ devices use the IEEE 802.1AS protocol over the network to synchronize. 

They can be configured to use the IEEE 1588-2008 protocol profile instead.[4] 

More Information about Synchronization 

The following documents will help you overcome typical hurdles in getting started 
with synchronized measurements: 

• Synchronizing analog input FieldDAQ devices with NI-DAQmx in LabVIEW—Visit 
ni.com/info and enter fdaisync. 

• Designing Ethernet measurement systems for synchronization, considering 
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topologies, masters, and third party devices—If topology changes result in a 
device’s master changing, executing tasks may be affected. Visit ni.com/info and 
enter fdenet. 

• How to achieve high accuracy measurements—Visit ni.com/info and enter 
fdsync. 

• Synchronization accuracy explained—Visit ni.com/info and enter syncacc. 
• Synchronizing FieldDAQ and TSN-Enabled Ethernet cDAQ Chassis to a PXI 

System—Visit ni.com/info and enter fd1588. 

Ethernet Ports and Networking 

The Ethernet Network Interface transfers data between the FieldDAQ device and the 
network. It gathers the data into TCP/IP packets that can be sent across the network 
and interpreted by the host. 

Ethernet Ports 

The FieldDAQ device has two 8-pin X-coded M12 Ethernet ports—0 and 1. You can use a 
shielded straight-through Ethernet or an Ethernet crossover cable with either of the 
Ethernet ports to network your device to a computer host, NI Linux Real-Time 
controller, another FieldDAQ device, or any network connection on the same subnet. 
Refer to Topology Options for more information about using these ports in various 
topologies. 

Figure 1. Ethernet Connector Pinout 
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Note Refer to Setting up the FieldDAQ Device or Connecting to a Real-Time 
Controller for information about connecting the FieldDAQ device to a host 
computer or host real-time controller. 
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Table 9. Signal Descriptions 

Pin Number Wire Color Gigabit Ethernet 
Signal Fast Ethernet Signal 

1 Orange/White BI_DA+ TX+ 

2 Orange BI_DA- TX- 

3 Green/White BI_DB+ RX+ 

4 Green BI_DB- RX- 

5 Brown/White BI_DD+ No Connect 

6 Brown BI_DD- No Connect 

7 Blue/White BI_DC+ No Connect 

8 Blue BI_DC- No Connect 

You can use the Ethernet ports to reset the FieldDAQ device to factory-default settings. 
Refer to Resetting the FieldDAQ to Factory-Default Settings for more information. 

Cap the Ethernet ports when not in use. 

Ethernet LEDs 

Each Ethernet port has a green LED that indicates network activity and link speed. 

Table 10. LED State/Device Status 

LED State Device Status 

On Ethernet link 

Blinking, fast (12 blinks/s) Ethernet activity. Connected at 1,000 Mbit/s. 

Blinking, moderate (6 blinks/s) Ethernet activity. Connected at 100 Mbit/s. 

Blinking, slow (3 blinks/s) Ethernet activity. Connected at 10 Mbit/s. 

Off No Ethernet connection 

Internal Ethernet Switch 

The FieldDAQ device features a full hardware-accelerated internal Ethernet switch for 
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greater performance, wiring flexibility, and compatibility over standard Ethernet ports. 
The Ethernet switch exposes two Ethernet ports to the user. Either port can be used to 
connect the device to the network. The two ports can be used to connect multiple 
devices in a daisy-chain topology. The switch also supports the Rapid Spanning Tree 
Protocol (RSTP) algorithm, enabling ring topologies. Refer to Topology Options for 
more details. 

IEEE 802.1AS-2011IEEE 802.1AS-2011  Precision Time Protocol Precision Time Protocol 

The internal Ethernet switch is an IEEE 802.1AS time-aware bridge, compatible with 
the IEEE 802.1AS-2011 Precision Time Protocol. It can synchronize local measurement 
signals to other devices across an IEEE 802.1AS subnet. It can also serve as a bridge, 
synchronizing IEEE 802.1AS devices that are attached to each of the two ports. Refer to 
Synchronization across a Network for more details. 

IEEE 802.1Q Rapid Spanning Tree Protocol (RSTP) IEEE 802.1Q Rapid Spanning Tree Protocol (RSTP) 

It is possible to create loops in a network using the FieldDAQ device. To prevent these 
loops from disrupting the network, the FieldDAQ device implements the IEEE 802.1Q 
Rapid Spanning Tree Protocol (RSTP). Using this protocol, each FieldDAQ device can 
find the shortest path for incoming packets to reach the rest of the network. When 
multiple paths exist, this adds a form of redundancy. If a link fails, the protocol 
automatically switches to use the redundant link. This process can take several 
seconds in some cases. 

To gain these benefits on external switches connected to the FieldDAQ device, 
IEEE 802.1Q (RSTP) must be enabled. All external switches must be configured to allow 
the FieldDAQ device to transmit RSTP packets, known as Bridge Protocol Data Units 
(BPDU). If any switch has a feature—such as “BPDU guard”—enabled, the port 
connected to the FieldDAQ device is disabled and communication is lost. Refer to the 
documentation for your external switch for information about enabling RSTP and 
disabling BPDU guards on the switch. 

IEEE 1588-2008IEEE 1588-2008  Protocol Protocol 

The internal Ethernet switch can be configured to act as a 1588 "boundary clock" 
implementing the IEEE 1588 delay request-response default PTP profile (sometimes 
referred to as "default profile"). When so configured, it can synchronize local 
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measurement signals to other devices across an IP subnetwork and can serve as a 
bridge, synchronizing 1588 devices that are attached to each of the two ports. Refer to 
Synchronization across a Network for more details. 

FieldDAQ MAC Addresses FieldDAQ MAC Addresses 

The FieldDAQ device is associated with two MAC addresses—both of which are labeled 
on the device—device and switch. These MAC addresses are not associated with a 
particular Ethernet port, but both addresses can appear on both ports as necessary. 

Table 11. NI MAX Device and Switch MAC Addresses 

Device MAC Address Switch MAC Address 

Associated with the device's IP address 
Associated with the internal Ethernet 
switch—not associated with the device’s IP 
address 

Used by normal device traffic Used for Ethernet protocols for network 
configuration and synchronization 

Listed in MAX Not listed in MAX 

The switch MAC address is used to implement the following switch protocols: 

• IEEE 802.1AS-2011 (Precision Time Protocol) 
• IEEE 802.1Q (Rapid Spanning Tree Protocol [RSTP]) 

• IEEE 1588-2008 (Precision Time Protocol)[5] 

The switch MAC address only appears in packets exchanged between the switch 
embedded in the FieldDAQ device and the next Ethernet device. It will not propagate 
further in a properly configured network. For more information about the 
recommended configurations for networking the FieldDAQ device, refer to Topology 
Options. 

Note The IEEE 802.1AS protocol is an IEEE 1588 profile, but is incompatible 
with other IEEE 1588 profiles. When FieldDAQ devices are using the 
IEEE 802.1AS protocol to synchronize they cannot synchronize with devices 
that use other protocols or IEEE 1588 profiles and vice versa. 
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Topology Options 

Recommended networking topologies are described in this section. 

• Host—Can be a Windows computer or a real-time controller with the NI Linux 
Real-Time operating system, such as the IC-317x, cRIO-9035/9039 Sync, 
cRIO-904x/905x, or cDAQ-9132/9133/9134/9135/9136/9137 for LabVIEW Real-Time 

• Node—Can be any FieldDAQ device or IEEE 802.1AS-compliant CompactDAQ 
chassis, such as the cDAQ-9185/9189 

For more information about designing Ethernet measurement systems, visit ni.com/
info and enter fdenet. 

Line Topology Line Topology 

In a line topology—also known as daisy-chaining or bus topology—the host 
communicates directly with all nodes through one bus line. A standard Ethernet device 
or switch can be added to the end of the chain if desired and used as normal. Be aware 
that these devices will compete for network bandwidth with the FieldDAQ device. 
Reliable system design requires awareness of the bandwidth consumed by each device 
during operations. This topology offers no redundant links. 

Figure 22. Line Topology 

Networking

Node Node NodeHost

Advantages: 

• Simple and inexpensive installation, expansion, and troubleshooting 
• Ideal for low number of nodes. NI recommends a maximum of 15 nodes. 
• No external switch needed 
• Can cover long distances 

Disadvantages: 

• Any unpowered nodes and/or node failure disrupts network communication 
• Addition or removal of any node disrupts network communication 
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• Failure of any Ethernet cable and/or improper cable termination disrupts network 
communication 

• Network performance and synchronization affected when node count exceeds 15. 
Consider the Star Topology for systems that require a greater number of nodes. 

Ring Topology Ring Topology 

In a ring topology, the host communicates with all nodes through the most effective 
path. You must use an external switch in a ring topology. You must configure the 
network properly with a recommended external switch before creating redundant 
links in the network. Refer to External Switch Requirements for information about 
what to look for in an external switch. 

Figure 23. Ring Topology 
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Advantages: 

• Failure of any single Ethernet cable does not disrupt network communication 
• Additional nodes or heavier network traffic affects network performance less than 

the line topology 
• Simple installation 
• Ideal for a local networking solution 

Disadvantages: 

• Network traffic patterns can make troubleshooting difficult 

Note For information about daisy-chaining power, refer to Power 
Connectors and Wiring. 

Note Network configuration and programming require careful 
consideration. Visit ni.com/info and enter fdenet for information about 
exploiting link redundancy and automatically improving reliability. 
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• Requires an external switch 

Star Topology Star Topology 

In a star topology, the host communicates directly with each node through the 
external switch. You must use an external switch in a star topology; for network 
synchronization, you must use an external IEEE 802.1AS switch. Redundant links are 
recommended, but optional, in this topology. You must configure the network 
properly with a recommended external switch before creating redundant links in the 
network. Refer to External Switch Requirements for information about what to look for 
in an external IEEE 802.1AS switch. 

Figure 24. Star Topology 
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Advantages: 

• Unpowered nodes and/or node failure does not disrupt network communication 
with other nodes 

• Failure of any single Ethernet cable does not disrupt network communication 
when you have a redundant link 

• Additional nodes or heavier network traffic affects network performance less than 
the other topologies 

• Simple installation, expansion, and troubleshooting 

Note For information about daisy-chaining power, refer to Power 
Connectors and Wiring. 

Note Network configuration and programming require careful 
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Disadvantages: 

• Most costly of the recommended topologies 
• Requires an external switch (external IEEE 802.1AS switch for network 

synchronization) 
• Covers the least distance 

Other Topologies Other Topologies 

For information about designing Ethernet measurement systems for synchronization, 
visit ni.com/info and enter fdenet. 

External Switch Requirements 

To meet the minimum requirements for successful operation with FieldDAQ devices, 
any switch directly connected to the FieldDAQ device should be compliant with 
IEEE 802.1Q bridges and bridged networks. 

To take advantage of the network synchronization and network redundancy features 
of the FieldDAQ device, ensure that your network infrastructure meets certain 
requirements: 

• IEEE 802.1AS-2011 time-based synchronization support—Automatically 
synchronizes timebases and enables the use of time-based triggers and 
multi-device tasks between device across the network. 

• IEEE 802.1Q (Rapid Spanning Tree Protocol) support—Supports network 
redundancy functionality in ring and star topologies 
◦ Rapid Spanning Tree Protocol (RSTP) enabled 
◦ Bridge Protocol Data Units (BPDU) Guard disabled 

To learn more about recommended network switches and other network configuration 

consideration. Visit ni.com/info and enter fdenet for information about 
exploiting link redundancy and automatically improving reliability. 

Note For information about daisy-chaining power, refer to Power 
Connectors and Wiring. 
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best practices and requirements, visit ni.com/info and enter fdenet. 

Connecting to a Real-Time Controller 

You can use the FieldDAQ device as expansion I/O from certain NI Linux Real-Time 
controllers. Discover and configure the NI Linux Real-Time controller in NI MAX, then 
discover and configure the FieldDAQ device. 

To network the FieldDAQ device to a Real-Time controller, you need the following 
items. 

Complete the following steps. 

1. Install the LabVIEW, LabVIEW Real-Time Module, and controller driver software on 
the host machine as instructed in the getting started or quick start document for 
the Real-Time controller. 

2. Install NI-DAQmx on the host machine if the driver was not installed in step 1. 
a. Download NI-DAQmx from ni.com/downloads/drivers. Complete the 

instructions. 
b. Register your NI hardware online at ni.com/register when prompted. 
c. Download NI-DAQmx to the target using MAX. Refer to the MAX Remote 

Note When using an NI Real-Time controller as the host, you can only use 
select controllers with the NI Linux Real-Time operating system that support 
NI-DAQmx. Supported NI Linux Real-Time controllers include the IC-317x, 
cRIO-9035/9039 Sync, cRIO-904x/905x, and 

cDAQ-9132/9133/9134/9135/9136/9137 for LabVIEW Real-Time.[6] 

Note LabVIEW Real-Time 2017 or later required to use the FieldDAQ 
synchronization features. 

Note You can either use a shielded straight-through Ethernet cable or an 
Ethernet crossover cable to connect the FieldDAQ device directly to your 
computer. 
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Systems Help by selecting Help » Help Topics » Remote Systems in MAX. 

If you have problems installing your software, go to ni.com/support/daqmx. 

3. Set up your Real-Time controller hardware and install software to it as instructed in 
the getting started or quick start document for the Real-Time controller. 

4. For CompactRIO and IC controllers, perform a custom installation of the NI-DAQmx 
feature to the controller. In MAX, expand Remote Systems » your Real-Time 
Controller, and use the Add/Remove Software option. Select the custom 
installation option and the NI-DAQmx feature, then follow the prompts to complete 
the installation. 

5. Make signal connections for your application. 
6. Align and connect one end of the Ethernet cable to Ethernet port 0 on the FieldDAQ 

device, and the other end to a switch or network connection on the same subnet 
as your Real-Time controller, or directly to an open network port on your Real-
Time controller. For more information about the recommended configurations for 
networking the FieldDAQ device in a Real-Time system, refer to Topology Options. 

7. Power the device by aligning and connecting the power IN port on FieldDAQ to an 
external 9 V DC to 30 V DC power source with the 5-pin L-coded M12 power cable. 
For information about wiring your external power source to the power connector, 
refer to Wiring External Power to the FieldDAQ Device. The FieldDAQ device 
requires an external power supply that meets the specifications listed in the 
FD-11637 Specifications. 

The Power LED turns on. Refer to Power LED for information about Power LED 
status. 

8. To add the FieldDAQ to the software configuration on the Real-Time target, open 
NI MAX on the host computer. In the MAX configuration tree, expand Remote 
Systems » your Real-Time Controller » Devices and Interfaces » Network 
Devices. 

9. Click Add Network Device, and then Find Network NI-DAQmx Devices. 
10. In the Find Network NI-DAQmx Devices dialog box that opens, do one of the 

following: 
◦ Check the box that corresponds to your device in the Hostname column. 
◦ If you know the device IP address, such as 192.168.0.2, enter it into the Add 
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Device Manually field of the Find Network NI-DAQmx Devices window, and 
click the + button. 

◦ Enter the hostname of the device. The default hostname is FD11637-<serial 
number>. 

If your FieldDAQ device does not appear in Available Devices, click Refresh List. If 
the device still does not appear, contact your system administrator to confirm that 
the network is working and that a firewall is not interfering with discovery. For 
additional troubleshooting resources for the FieldDAQ device, refer to 
Troubleshooting Device Connectivity in this guide and the Finding a Network 
DAQ Device in MAX topic in the Measurement & Automation Explorer 
Help for NI-DAQmx. 

11. Click Add Selected Devices. The FieldDAQ device is added under the Real-Time 
controller in the MAX configuration tree. 

Figure 25. Adding the FieldDAQ Device to the Real-Time Controller in MAX 

12. If the FieldDAQ device is not reserved automatically, select the device and click the 
Reserve Network Device button. Refer to Reserving the Device in MAX for more 
information. 

13. Self-test your device in MAX by expanding Devices and Interfaces » Network 
Devices, right-clicking your FieldDAQ device, and selecting Self-Test. Self-test 
performs a brief test to determine successful device installation. When the self-test 
finishes, a message indicates successful verification or if an error occurred. If an 
error occurs, refer to ni.com/support/daqmx. 
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14. Run a Test Panel in MAX by expanding Devices and Interfaces » Network Devices »
your FieldDAQ device, right-clicking the bank of connectors in your FieldDAQ 
device, and selecting Test Panels. If the test panel displays an error message, refer 
to ni.com/support. Click Close to exit the test panel. 

Troubleshooting Device Connectivity 

If your FieldDAQ device becomes disconnected from the network, open MAX and try 
the following: 

• After moving the device to a new network, NI-DAQmx may lose connection to the 
device. In this case, click Reconnect to provide NI-DAQmx with the new hostname 
or IP address. 

• The FieldDAQ device icon indicates whether it is recognized and present on the 
network. If a connected device appears as disconnected in the configuration tree 
in MAX, select Self-Test or Reset. If successful, the device icon changes to dark 
grey. 

Figure 26. MAX Icons and States 

21 3

1. Discovered, but Not Added to the Network 
2. Recognized, Present, and Reserved on the Network 
3. Recognized, but Disconnected from the Network, Unreserved, or Reserved by 

Another Host 

Note When in use, the FieldDAQ device may become warm to the touch. This 
is normal. 

Note M12 connectors must be mated to cables or have caps installed on 
them to meet IP65/IP67 requirements. Cover the unused connectors with the 
included plastic caps whenever water, dust, or dirt are present. 

Note Avoid long periods of exposure to sunlight. 
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For additional troubleshooting resources for the FieldDAQ device, refer to the Finding 
a Network DAQ Device in MAX topic in the Measurement & Automation 
Explorer Help for NI-DAQmx. 

Reserving the Device in MAX 

When the FieldDAQ device is connected to a network, multiple users can access the 
device. To perform any DAQ functionality on the device, including reset and self-test, 
you must reserve the device in MAX. In MAX, an unreserved device or device reserved 
by another host appears with an X and a reserved device appears as dark grey. Only 
one user at a time can reserve the FieldDAQ device. 

If the device was not reserved automatically after it was added (Add Device), you can 
reserve the device in MAX by expanding Devices and Interfaces » Network Devices, 
selecting the device, and clicking the Reserve Network Device button. The Override 
Reservation dialog box opens when you attempt to explicitly reserve a device. 
Agreeing to override the reservation forces the FieldDAQ device to be reserved by the 
current user. 

STATUS LED 

The FieldDAQ device has a STATUS LED. 

Table 12. LED State/Device Status 

LED Color and State Device Status 

Off 
Device is reserved by NI-DAQmx but there is no 
activity, the device is not powered, or the device 
is not reserved by NI-DAQmx. 

Yellow, solid Device firmware is booting or updating. 

Red, blinking 

Device has reset to factory default or the 
firmware image is corrupted. If you are not 
performing a factory default reset, as listed in 
Resetting the FieldDAQ to Factory-Default 
Settings, contact NI for support on corrupted 
firmware. 

Green, solid Device is reserved and an NI-DAQmx task is 
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LED Color and State Device Status 

running. 

Resetting the FieldDAQ to Factory-Default Settings 

To reset your FieldDAQ device to factory-default settings, complete the following steps. 

1. Verify the power source is turned off. 

2. Connect Ethernet port 0 and port 1 with an Ethernet cable. 

Figure 27. Connecting Port 0 and Port 1 

0

10/100/1000

SYNC

1
LINK/ACT

3. Turn on the power source to the device. After about 15 seconds, the STATUS LED 
blinks red indicating that the device has been restored to factory-default settings. 

4. Reconnect the Ethernet port 0 to the host. 
5. Turn off and then turn on the power source to the device. 

The FieldDAQ device factory-set defaults are listed in the following table. 

Table 13. Device Default Settings 

Attribute Value 

Hostname FD11637-<serial number> 

IP DHCP or Link Local 

Comment Empty 

Default login 

User name = admin 

Password = no password required 
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Mounting 

FieldDAQ can be mounted on any substrate in any orientation if the ambient 
temperature is 75 °C or less. However, to ensure proper functionality during use above 
75 °C, you must mount the FieldDAQ device in the reference mounting configuration 
shown in the following figure. Observe the following guidelines to mount the FieldDAQ 
device in the reference mounting configuration. 

Figure 28. Reference Mounting Configuration 
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Up

1. Vertical mounting orientation. 
2. Mount the FieldDAQ device directly to a metallic surface that is at least 1.6 mm 

(0.062 in.) thick and extends a minimum of 76.2 mm (3 in.) beyond all edges of the 
device. 

3. Observe the cooling dimensions in Mounting Requirements. 
4. Allow space for cabling clearance according to the Mounting Requirements. 
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Before using any mounting methods, record the serial number from the back of the 
FieldDAQ device so that you can identify it in MAX. You will be unable to read the serial 
number after you mount the device. 

Mounting Requirements 

Your installation must meet the following requirements for cooling and cabling 
clearance. Allow 76.2 mm (3.00 in.) on all sides of the device for air circulation, as 
shown in the following figure. 

Figure 29. Cooling Dimensions 
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Allow the appropriate space in front of the device for cabling clearance, as shown in 
the following figure. 

Figure 30. Cabling Clearance 

Cabling
Clearance
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Measure the ambient temperature at each side of the FieldDAQ device, 76.2 mm 
(3.00 in.) from the side and 25.4 mm (1.00 in.) forward from the rear of the device. Refer 
to the following figures for ambient temperature locations for horizontal and vertical 
mounting configurations. 

Figure 31. Ambient Temperature Locations, Horizontal Mounting Configuration 
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Figure 32. Ambient Temperature Locations, Vertical Mounting Configuration 
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Dimensions 

For detailed dimensional drawings and 3D models, visit ni.com/dimensions and search 
for FD-11637. 
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Mounting the Device Directly on a Flat Surface 

For environments with high shock and vibration, NI recommends mounting the 
FieldDAQ device directly on a flat, rigid surface using the mounting holes on the 
device. This mounting technique requires four M5 or 10-32 panhead or sockethead cap 
screws appropriate for the surface. 

Complete the following steps to mount the FieldDAQ device directly on a flat surface. 

1. Prepare the surface for mounting the device using the surface mounting 
dimensions. 
Figure 33. Surface Mounting Dimensions 

34.0 mm
(1.33 in.)

STATUS

IN

10 A  TOTAL
9-30 V

FieldDAQ

OUT

0

10/100/1000

LINK/ACT

SYNC

1

184.0 mm
(7.24 in.)

2. Align the device on the surface. 
3. Fasten the device to the surface using the M5 or 10-32 screws. Tighten the screws 

to a maximum torque of 2.5 N · m (25.0 lb · in.). 
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Figure 34. Fastening the Device to the Surface 

STATUS

IN

10 A  TOTAL
9-30 V

FieldDAQ

OUT

0

10/100/1000

LINK/ACT

SYNC

1

Alternate Mounting Configurations 

The maximum operating temperature of 85 °C may be reduced for any mounting 
configuration other than the reference mounting configuration. A 10 °C (18 °F) 
reduction in maximum operating temperature is sufficient for most alternate 
mounting configurations. Follow the mounting requirements for all mounting 
configurations. 

The published accuracy specifications, although not guaranteed for alternate 
mounting configurations, may be met depending on the system power and the 
thermal performance of the alternate mounting configuration. 

Contact NI for further details regarding the impact of common alternate mounting 
configurations on maximum operating temperature and accuracy. 

Mounting the Device on a DIN Rail Mounting the Device on a DIN Rail 

The FD-11960 DIN rail mounting kit is an accessory you can use to mount a FieldDAQ 
device to a DIN rail. The hardware in the FD-11960 DIN rail mounting kit includes a 
bracket panel, a DIN rail clip, four M5 x 10 mm screws, four M5 washers, and two 8-32 x 
1/4 in. screws. 

Complete the following steps to install a FieldDAQ device onto a DIN rail using the 
FD-11960 DIN rail mounting kit. 
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1. Attach the FieldDAQ device to the bracket panel using the included M5 x 10 mm 
screws and M5 washers. The front of the bracket panel, which includes an outline 
of the FieldDAQ device, should be attached to the back of the FieldDAQ device. 

2. Attach the DIN rail clip to the FieldDAQ device and bracket panel using the 
8-32 x 1/4 in. screws included in the kit. Tighten the screws to a maximum torque 
of 1.3 N · m (11.5 lb · in.). 
Figure 35. Attaching a FieldDAQ Device to the Bracket and DIN Rail Clip 
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1. Bracket panel 
2. DIN rail clip 
3. M5 x 10 mm screw 
4. 8-32 x 1/4 in. screw 
5. M5 washers 

3. Clip the device onto the DIN rail. 
Figure 36. DIN Rail Clip Parts Locator 
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1. DIN rail clip 

Note You can also horizontally mount the FieldDAQ device to the DIN 
rail. 
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2. DIN rail spring 
3. DIN rail 

Figure 37. FD-11960 Dimensions 
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Calibration 

The FD-11637 can be verified and adjusted. Refer to the FD-11637 Calibration 
Procedure for a detailed calibration procedure. Ensure that your driver software is 
updated to a version that supports calibration for your FieldDAQ device. 

Table 14. FD-11637 Calibration Driver Support 

Driver Earliest Version Support 

NI-DAQmx 18.5 

Firmware 

Firmware can be updated through NI MAX or the web interface to the device. For 
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FieldDAQ firmware information and updates, visit ni.com/info and enter the Info Code 
fdfw. 

Maintenance 

If you need to clean your device, wipe it with a dry towel. 

Where to Go from Here 
This section lists where you can find example programs for the FieldDAQ device and 
relevant documentation. 

Example Programs 

NI-DAQmx software includes example programs to help you get started programming 
with the FieldDAQ device. Modify example code and save it in an application, or use 
examples to develop a new application, or add example code to an existing 
application. 

To locate NI software examples, go to ni.com/info and enter the Info Code daqmxexp. 

To run examples without the device installed, use an NI-DAQmx simulated device. For 
more information, in Measurement & Automation Explorer (MAX), select Help » Help 
Topics » NI-DAQmx » MAX Help for NI-DAQmx and search for simulated devices. 

Related Documentation 

Each application software package and driver includes information about writing 
applications for taking measurements and controlling measurement devices. The 
following references to documents assume you have NI-DAQmx 17.6 or later. 

Note M12 connectors must be mated to cables or have caps installed on 
them to meet IP65/IP67 requirements. Cover the unused connectors with the 
included plastic caps whenever water, dust, or dirt are present. 

Note Avoid long periods of exposure to sunlight. 
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FieldDAQ FieldDAQ 

The FD-11637 Quick Start, packaged with your device, describes how to install your 
NI-DAQmx for Windows software, how to set up your FieldDAQ device, and confirm that 
your device is operating properly. 

The FD-11637 Specifications lists all specifications for your FieldDAQ device. Go to 
ni.com/manuals and search for FD-11637. 

The FD-11637 Safety, Environmental, and Regulatory Information, 
packaged with your device, includes important compliance precautions and 
connection information for your FieldDAQ device. 

The FD-11637 Calibration Procedure contains information for calibrating your 
FieldDAQ device. Go to ni.com/manuals and search for FD-11637. 

NI-DAQmx NI-DAQmx 

The NI-DAQmx Readme lists which devices, ADEs, and NI application software are 
supported by this version of NI-DAQmx. Select Start » All Programs » National 
Instruments » NI-DAQmx » NI-DAQmx Readme. 

The NI-DAQmx Help contains API overviews, general information about 
measurement concepts, key NI-DAQmx concepts, and common applications that are 
applicable to all programming environments. Select Start » All Programs » National 
Instruments » NI-DAQmx » NI-DAQmx Help. 

LabVIEW NXG LabVIEW NXG 

Refer to the Taking NI-DAQmx Measurements lessons to assist in getting started 
in LabVIEW NXG, beginning with NI-DAQmx API Basics. To access these lessons, 
enter taking NI-DAQmx measurements in the Search bar in LabVIEW NXG. 

Flexlogger Flexlogger 

Configuring I/O Channels in the Flexlogger Manual presents information for 
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configuring channels and logging data in FlexLogger. Go to ni.com/info and enter the 
Info Code flexloggeriochannels. 

LabVIEW LabVIEW 

Use the LabVIEW Help, available by selecting Help » LabVIEW Help in LabVIEW, to 
access information about LabVIEW programming concepts, step-by-step instructions 
for using LabVIEW, and reference information about LabVIEW VIs, functions, palettes, 
menus, and tools. Refer to the following locations on the Contents tab of the 
LabVIEW Help for information about NI-DAQmx: 

• VI and Function Reference » Measurement I/O VIs and Functions » DAQmx - Data 
Acquisition VIs and Functions—Describes the LabVIEW NI-DAQmx VIs and 
functions. 

• Property and Method Reference » NI-DAQmx Properties—Contains the property 
reference. 

• Taking Measurements—Contains the conceptual and how-to information you 
need to acquire and analyze measurement data in LabVIEW, including common 
measurements, measurement fundamentals, NI-DAQmx key concepts, and device 
considerations. 

LabVIEW Real-Time LabVIEW Real-Time 

The Real-Time Module Concepts book of the LabVIEW Real-Time Module 
Help includes conceptual information about real-time programming techniques, 
application architectures, and Real-Time Module features you can use to create 
real-time applications. Refer to the Real-Time Module Concepts before attempting 
to create a deterministic real-time application. 

LabWindows/CVI LabWindows/CVI 

The Data Acquisition book of the LabWindows/CVI Help contains Taking an 
NI-DAQmx Measurement in LabWindows/CVI, which includes step-by-step 
instructions about creating a measurement task using the DAQ Assistant. In 
LabWindows™/CVI™, select Help » Contents, then select Using LabWindows/CVI » Data 
Acquisition. This book also contains information about accessing detailed information 
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through the NI-DAQmx Help. 

The NI-DAQmx Library book of the LabWindows/CVI Help contains API overviews 
and function reference for NI-DAQmx. Select Library Reference » NI-DAQmx Library in 
the LabWindows/CVI Help. 

Microsoft Visual Studio Support Microsoft Visual Studio Support 

You can use the NI-DAQmx .NET class library to communicate with and control an NI 
data acquisition (DAQ) device. Documentation for the NI-DAQmx .NET class library is 
available by selecting Start » All Programs » National Instruments » NI-DAQmx » NI-
DAQmx Documentation and then opening the NINETDAQmxFxXX.chm help file 
corresponding to the version of NI-DAQmx .NET Framework language support you 
have installed. 

• Measurement Studio Support for NI-DAQmx—If you program your NI-DAQmx-
supported device in Visual Studio using Visual C# or Visual Basic .NET, you can 
interactively create channels and tasks using Measurement Studio and the DAQ 
Assistant. Additionally, you can use Measurement Studio to generate the 
configuration code based on your task or channel. Refer to the DAQ Assistant 
Help for additional information about generating code. 

To create an NI-DAQmx application using Visual Basic .NET or Visual C#, follow 
these general steps: 

1. In Visual Studio, select File » New » Project to launch the New Project dialog 
box. 

2. Choose a programming language (Visual C# or Visual Basic .NET), and then 
select Measurement Studio to see a list of project templates. 

3. Select NI DAQ Windows Application. Choose a project type. You add DAQ tasks 
as a part of this step. 

• .NET Languages without NI Application Software—With the Microsoft .NET 
Framework, you can use the NI-DAQmx .NET class library to create applications 
using Visual C# and Visual Basic .NET without Measurement Studio. Refer to the 
NI-DAQmx Readme for specific versions supported. 
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ANSI C without NI Application Software ANSI C without NI Application Software 

The NI-DAQmx Help contains API overviews and general information about 
measurement concepts. Select Start » All Programs » National Instruments » NI-
DAQmx » NI-DAQmx Help. 

The NI-DAQmx C Reference Help describes the NI-DAQmx Library functions, which 
you can use with National Instruments data acquisition devices to develop 
instrumentation, acquisition, and control applications. Select Start » All Programs »
National Instruments » NI-DAQmx » Text-Based Code Support » NI-DAQmx C 
Reference Help. 

Training Courses 

If you need more help getting started developing an application with NI products, NI 
offers training courses. To enroll in a course or obtain a detailed course outline, refer to 
ni.com/training. 

Technical Support on the Web 

For additional support, refer to ni.com/support or ni.com/examples. 

Many DAQ specifications and user guides and manuals are available as PDFs. You must 
have Adobe Reader 7.0 or later (PDF 1.6 or later) installed to view the PDFs. Refer to the 
Adobe Systems Incorporated website at www.adobe.com to download Adobe Reader. 
Refer to the National Instruments Product Manuals Library at ni.com/manuals for 
updated documentation resources. 

© 2025 National Instruments Corporation. 
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